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Приводится возможность моделирования мехатронных модулей движения в пакете 

Matlab на примере пневмопривода на основе цилиндра одностороннего действия. Показано, что 
такое моделирование позволяет эффективно выполнять проектирование сложных мехатронных 
модулей.  
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Введение. Термин мехатроника обозначает область науки и техники, лежащую на стыке 
механики, микроэлектроники, информатики и автоматики [1]. Мехатронные системы, включающие в 
свой состав механические и электромеханические преобразователи с электронной коммутацией 
(актуаторы), различного вида датчики (сенсоры), силовые полупроводниковые преобразователи, 
микроконтроллеры и персональные компьютеры, широко применяются и интенсивно развиваются. 

Если рассматривать мехатронную систему укрупненно, то в ней можно выделить три подсистемы: 
– информационную, в состав которой входят датчики и система управления; 
– энергоэлектронную, содержащую силовые преобразователи и вторичные источники питания; 
– электромеханическую, содержащую объект управления, механический и электромехани-

ческий преобразователь. 
Задачей мехатронной системы является преобразование входной информации, поступающей с 

верхнего уровня управления, в целенаправленное механическое движение с управлением на основе 
принципа обратной связи.  

Базовыми функциональными элементами промышленных мехатронных систем считают 
мехатронные модули движения (ММД). 

ММД – это синергетическая совокупность механических, электротехнических, электронных 
компонентов, а также информационных и программных средств, реализующая достижение заданного 
управляемого движения. 

Современные образцы технологического оборудования, могут иметь в своем составе от одного до 
нескольких мехатронных модулей движения. Основная функция этих модулей состоит в осуществлении 
пространственного перемещения рабочих органов и исполнительных устройств по некоторой заранее 
заданной программной траектории.  

Проектирование и исследование мехатронных систем связанно с использованием сложного и 
дорогостоящего оборудования. В этом случае прибегают к моделированию – методу, при котором 
элемент реальной системы или процесса заменяется его моделью. 

 
1. Построение комплексной модели типового линейного гидропривода ММД с 

использованием библиотеки SimScape пакета Matlab. Рассмотрим пример комплексной модели 
типового линейного гидропривода ММД для исследования его динамических характеристик.  

Для построения модели гидропривода используется пакет прикладных программ для Matlab. 
Начиная с версии R2007а, в состав этого пакета входит специализированная библиотека SimScape для 
моделирования многомерных физических систем. На основе использования блоков этой библиотеки 
могут быть эффективно построены модели электрических, механических и гидравлических систем. В 
рассматриваемом примере имеет место гидравлическая система, поэтому при составлении модели 
применяются блоки SimHydraulics библиотеки SimScape [1, 2]. Модель типового гидропривода 
приведена на рисунке 1. В качестве исполнительного механизма в этой схеме выступает блок 
гидравлического цилиндра одностороннего действия (Single-Acting Hydraulic Cylinder). 

На рисунке 2 приведена еще одна комплексная модель гидравлической системы на базе 
автоматизированного гидропривода. В отличие от первой модели, в качестве исполнительного 
устройства используется гидравлический цилиндр двустороннего действия. 
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Рисунок 1 – Модель автоматизированного гидропривода  

с исполнительным устройством – цилиндром одностороннего действия 

The circuit demonstrates the use of a 4-way valve in combination with a
double-acting cyl inder in a simple closed-loop actuator. The cyl inder 

model is a subsystem that, unlike the regular library block, does not account 
for fluid compressibi li ty in cylinder chambers.
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Рисунок 2 – Модель автоматизированного гидропривода  

с исполнительным устройством – цилиндром двустороннего действия 
 
Для построения подобных моделей используются блоки библиотеки SimHydraulic.  
Моделирование системы проводится с использованием компонентов, учитывающих влияние 

реальных физических характеристик и величин, связывающих все блоки модели. При этом, основной 
подход для моделирования основан на передаче физической энергии от блока к блоку с учетом 
физических размерностей. Также есть возможность учитывать направление движения жидкости в 
системе. Это позволяет лучше понять сущность модели и реального гидропривода, для которого эта 
модель построена. 

 
2. Разработка пользовательских блоков исполнительных элементов ММД на основе 

математических моделей на примере пневматического привода. Рассмотренная комплексная модель 
гидропривода ММД обладает широкими возможностями для исследования работы гидравлической 
системы при различных значениях параметров модели, начиная от типа рабочей жидкости, заканчивая 
величиной открытия отверстия регулируемого дросселя. Тем не менее, есть один большой недостаток – 
от пользователя скрыта математическая основа модели, т.к. все блоки представляют собой «черный 
ящик», который позволяет только устанавливать значения определенных параметров системы. 

Для более глубокого изучения сущности модели, необходимо использовать подход, который 
основан на построении модели «с нуля», т.е. вначале проводится математическое описание всех 
физических процессов в модели и только потом происходит переход к компьютерному моделированию. 
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Цикл построения комплексной модели может быть рассмотрен на примере пневмопривода ММД с 
цилиндром одностороннего действия, расчетная схема которого изображена на рисунке 3. 

 

 
Рисунок 3 – Расчетная схема пневмопривода на основе цилиндра одностороннего действия 

 
Принцип действия такого приводного механизма состоит в следующем. Все элементы 

пневматической системы соединены магистралью, по которой циркулирует сжатый воздух. При 
срабатывании электромагнита (Э) 3/2-пневмораспределителя 1, последний переключается в левое 
положение. При этом сжатый воздух через входной канал Mp  распределителя поступает на вход 

регулируемого дросселя 2. В свою очередь дроссель позволяет регулировать величину расхода воздуха в 
магистрали, который поступает в бесштоковую полость пневмоцилиндра 3. Под действием давления 1p  

осуществляется перемещение присоединенной к штоку массы m . При обесточивании Э и переключении 
пневмораспределителя 1 в правое, показанное на рисунке 3 положение под действием его пружины 
возврата, происходит обратный ход поршня за счет атмосферного давления 

а
p , которое воздействует на 

поршень со стороны штока, а также за счет действия возвратной пружины цилиндра. 
Уравнение движения поршня при прямом ходе (выдвижении) имеет вид [2, 3] 

( ) FxjSpp
td

xd
m прa −−−= 112

2

,     (1) 

где m  – масса подвижных частей пневмопривода и присоединенных к нему поступательно-движущихся 
частей; x  – координата перемещения поршня; 1p  – давление в бесштоковой полости; ap  – атмосферное 

давление; 1S  – площадь торца поршня со стороны бесштоковой полости; прj  – жесткость пружины; F  – 

результирующая всех постоянных сил, действующих на шток с поршнем; t  – время перемещения 
поршня на заданное расстояние x . 

Уравнение движения поршня при обратном ходе (втягивании) 

( ) FxjSpp
td

xd
m прa ′−−−−= 122

2

,    (2) 

где 2p  – остаточное давление в бесштоковой полости (как правило, при обратном ходе принимают 

app =2 ). 

Результирующая сила F ′  в уравнении (2) должна иметь знак минус, чтобы поршень вернулся в 
исходное положение. 

В дополнение к уравнениям (1), (2) используются условия: 
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где  MINMAX ll ,  – соответственно максимально и минимально допустимая длина выдвижения штока. 
Уравнения, описывающие изменение давления 1p  в полости нагнетания и давления 2p  в полости 

всасывания, согласно [3, 5] имеют вид: 
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Уравнения (1) – (5) представляют собой математическую модель пневмоцилиндра одностороннего 
действия. 

Построение схемы модели привода с использованием стандартных блоков библиотеки Simulink 
выполняется следующим образом. 

Предварительно преобразуются уравнения (1) и (2) к следующему виду: 

( )[ ]

( )[ ] .
1

;
1
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2
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2
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td
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FxjSpp

td

xd

прa

прa

′−−−−=
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    (6) 

Затем разделяются переменные, входящие в уравнения (4) – (6) на две группы. К первой группе 
относятся переменные, значение которых зависит от типа привода, но в течение времени моделирования 
остается постоянным. Ко второй группе – переменные, значение которых в течение времени 
моделирования изменяется. Результат такого разделения приведен в таблице 1. 

Таблица 1 – Разделение переменных модели 

Переменные, имеющие постоянное значение 
Переменные, изменяющие свое значение в 

течение времени моделирования 

MT , k , R  x  

1S , 2S , MINMAX ll , , m , c  Ma pppp ,,, 21  

21, ff  F  
 
Схема модели привода будет иметь вид, показанный на рисунке 4. 

p1 2

V

1

x

V

x

p_A

p_M

p2

p2

V

x

p_M

p1

p1

1
s

dx1

1
s

dV1

 > 

Switch1

 > 

Switch

Scope1

-K-

Gain2

-K-

Gain1

-K-

Gain

0

Constant1

p_a

Constant

2

p_М

1

F

 
Рисунок 4 – Структурная схема привода на базе цилиндра одностороннего действия 

 
На данной схеме блоки р1 и р2 представляют собой подсистемы реализующие дифференциальные 

уравнения изменения давления газа (жидкости) в полости нагнетания и выхлопной полости, схемы этих 
блоков показаны на рисунке 5. 
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В соответствии с принятым разделением переменных модели (таблица 4.1) входными величинами 
являются внешняя сила F  и давление в линии питания p , выходными – текущее перемещение и 

скорость поршня цилиндра, x  и V . Постоянные параметры модели разбиты на три категории: 
параметры цилиндра, параметры рабочего вещества и параметры линии. 
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Рисунок 5 – Simulink-схемы блоков р1 (а) и р2 (б) 

 
Представленные на рисунке схемы удобно объединить в подсистему, представленную на  

рисунке 6.  

x
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p
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Рисунок 6 – Подсистема (блок) пнвмоцилиндра одностороннего действия  
с демпфированием поршня в конце перемещения (в крайних точках) 

 
Для рассматриваемой подсистемы (блока) средствами Matlab создается специальное диалоговое 

окно, изображенное на рисунке 6, которое предназначено для ввода параметров пневмоцилиндра 
пользователем.  
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Рисунок 7 – Внешний вид окна диалога ввода параметров пневмоцилиндра 

 
Схема моделирования прямого хода поршня пневмоцилиндра представлена на рисунке 8. Ввиду 

принятых упрощений блок дросселя на схеме отсутствует. 
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Рисунок 8 – Simulink-модель пневмоцилиндра 

 
3. Пример моделирования пневмоцилиндра. Выполним моделирование пневмоцилиндра 

двустороннего действия. В качестве давления в полости нагнетания зададим 44 ≈= aM pp  атм., в 

полости выхлопа зададим 1≈= aA pp  атм. Максимальная длинна выдвижения штока 15,0=MAXl  м, 

начальное положение штока 01,001 =y  м. Численные значения параметров для воздуха при температуре 

293=MT  (20 ºС) и давлении 101325=ap  Па (1 атм.), 4,1=k ; 287=R  Дж/(кг*К). 

При таких условиях шток должен выдвинуться вперед до значения 15,0=MAXl  м. Результаты 

моделирования показаны на рисунке 9, а.  
Смоделируем также ситуацию, когда при таких же параметрах газа давление в линии нагнетания 

равно 1≈= aM pp  атм., в полости выхлопа зададим 44 ≈= aA pp  атм., а начальное положение штока 

15,002 =y  м. В такой ситуации шток изначально выдвинут, и при подачи давлений должен задвинуться 

назад, до значения 01,0=MINl  м. Результаты также даны на рисунке 9, б. 
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а)  

б)  
 

Рисунок  9 – Результаты моделирования пневмоцилиндра двустороннего действия  
при выдвижении (а) и при втягивании (б) 

 
4. Создание библиотеки моделей исполнительных элементов ММД в Simukink. Библиотека 

пользователя, может быть создана в специальном окне библиотек пользователя. Это окно открывается 
командой File > New > Library . Нетрудно заметить, что это окно имеет несколько упрощенный 
интерфейс. В частности, в нем нет средств запуска процесса моделирования. Окно создается пустым. В 
конце строки состояния окна видно сообщение), говорящее о том, что библиотека открыта и может 
изменяться и пополняться.  

Для переноса блоков в окно библиотеки достаточно, расположив рядом окно обозревателя 
библиотек и окно новой библиотеки, перетащить в последнюю нужные блоки. Связи между ними и 
встроенной библиотекой редактировать не надо. Можно также перенести в окно новой библиотеки и 
созданные маскированные подсистемы. Прямо перетащить их в окно новой библиотеки нельзя – в ней 
действует «правило одностороннего движения».  

После заполнения блоками новая библиотека блокируется командой меню Edit > Locked. После 
этого библиотека становится недоступной для пополнения и модернизации. Впрочем, можно 
разблокировать библиотеку командой Edit > Unlocked и выполнить  ее  модернизацию. Завершается 
создание новой библиотеки ее записью на диск с помощью команды меню File > Save as... окна новой 
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библиотеки. Библиотека хранится в виде файла с заданным именем и расширением (таким же, как и у 
файлов моделей Simulink).  

После сохранения файла библиотеки ее нужно добавить в перечень доступных путей Matlab, 
предварительно добавив скрипт-файл функции slblocks.m, содержащий набор необходимых команд для 
Matlab. 

В итоге для создания библиотеки пользователя нужно выполнить такие действия [6]: 
– создать файл библиотеки: File > New > Library; 
– скопировать в файл библиотеки блоки и сохранить этот файл; 
– поместить в папку с файлом новой библиотеки файл slblocks.m, содержащий набор команд 

для отображения библиотеки пользователя в дереве библиотек Simulink; 
– добавить в Matlab путь с папкой, где находятся файл библиотеки и файл с функцией 

slblocks.m; 
– перезапустить Matlab. 
На рисунке 10 показан вид дерева библиотек Simulink, где видно, содержимое созданной 

библиотеки «pneumatics», содержащей разработанные элементы. 
 

 
 

Рисунок 10 – Дерево библиотек Simulink с разработанной библиотекой «pneumatics» 
 
 
Заключение 
Настоящая работа посвящена вопросам построения математических моделей мехатронных 

модулей движения. В качестве инструмента моделирования взят пакет прикладных программ 
Matlab&Simulink. Наличие специальных средств для моделирования ММД в Matlab&Simulink (например, 
библиотеки SimScape, SimPowerSystems и SimHydraulics), на первый взгляд, упрощает решение задач 
моделирования. Однако, указанные специализированные средства (библиотеки блоков) имеют ряд 
недостатков, главным из которых является недоступность и скрытость математической основы блоков и 
их компонентов для пользователя, а также относительная дороговизна указанных расширений Simulink, 
т.е. указанные библиотеки не входят в стандартный набор пакета программ Matlab&Simulink.  

В связи с вышесказанным становится целесообразным использовать подход, который основан на 
построении модели «с нуля». Процесс разработки такой модели на примере пневмопривода ММД с 
цилиндром одностороннего действия показан в разделе 2. Здесь с помощью стандартных средств 
программы Simulink был разработан отдельный блок, моделирующий работу указанного линейного 
пневмопривода. Разработанный блок имеет стандартный Simulink-интерфейс для ввода параметров, что 
облегчает работу пользователя, как уже работавшего со средой Simulink, так и для новичка.  

Аналогичным образом были разработаны модели ММД на базе линейных и поворотных 
пневматических механизмов, которые были объединены в новую пользовательскую библиотеку 
«pneumatics». При разработке данной библиотеки использовались только стандартные средства пакета 
Matlab&Simulink, входящие в минимальную комплектацию программного продукта. Этот факт является 
существенным преимуществом предлагаемой разработки, поскольку значительно повышают ее 
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универсальность и мобильность. Перспективы исследований заключаются в расширении разработанной 
Simulink-библиотеки элементами, моделирующими мехатронные модули движения различной 
конструкции, и принципов действия (пневматические, гидравлические, электрические)  
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Крамарь В.О., Кабанов О.О., Альчаков В.В. Моделювання мехатронних модулів руху 
Наводиться можливість моделювання мехатронних модулів руху в пакеті Matlab на прикладі 

пневмопривода на основі циліндра односторонньої дії. Показано, що таке моделювання дозволяє 
ефективно виконувати проектування складних мехатронних модулів. 

Ключові слова: мехатроніка, пневмоцилиндр, моделювання, Simulink. 
 
 

Kramar V.A., Kabanov A.A., Alchakov V.V. Modeling of mechatronic motion modules 
Provided is the possibility of modeling of mechatronic motion modules in the Matlab package. An 

example of modeling of an actuator based on a single-acting cylinder is considered. It is shown that such 
modeling can effectively perform a design of complex mechatronic modules. 

Keywords: mechatronics, pneumatic cylinder, modeling, Simulink. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 


